Contents

Chapter 1 Getting Started ................................................. 1
  Finding information .................................................. 1
  Overview ............................................................... 2
  Setting up the J3400 .................................................. 6

Chapter 2 Features ......................................................... 9
  Pen ................................................................. 10
  Front panel buttons .................................................. 11
  Battery status light ................................................... 12
  Motion QuickNav ....................................................... 13
  Camera ............................................................... 14
  Security ............................................................... 15
  Windows Security button .............................................. 15
  Fingerprint reader ..................................................... 16
  Display ............................................................... 16
  View Anywhere display (optional) ................................... 17
  Microphones ......................................................... 17
  Speakers ............................................................ 17
  Ambient light sensor (ALS) ............................................ 17
  Motion DataGuard ..................................................... 17
  USB 2.0 ports ......................................................... 18
  Headphones port ....................................................... 18
  Microphone port ....................................................... 18
  Security slot .......................................................... 19
  VGA port ............................................................ 19
  Ethernet port ........................................................ 19
  Docking connector ..................................................... 19
  Smart card reader slot (optional) ..................................... 19
  Express card slot (optional) .......................................... 20
  SIM slot .............................................................. 20
  Wi-Fi (802.11a/g/n wireless) ......................................... 20
  Mobile Broadband (optional) ......................................... 21
  Bluetooth wireless (optional) ......................................... 21
  Power adapter ......................................................... 21
  Battery ............................................................... 22
  J-Series FlexDock (optional) ......................................... 22
  J-Series Mobile Keyboard (optional) ................................. 23
# Chapter 3 Using your Tablet PC

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Motion Dashboard</td>
<td>26</td>
</tr>
<tr>
<td>Using the Motion utility in the notification area</td>
<td>27</td>
</tr>
<tr>
<td>Using the pen</td>
<td>28</td>
</tr>
<tr>
<td>Using Tablet PC Input Panel</td>
<td>29</td>
</tr>
<tr>
<td>Configuring pen options</td>
<td>29</td>
</tr>
<tr>
<td>Using personalized handwriting recognition</td>
<td>30</td>
</tr>
<tr>
<td>Configuring front panel buttons</td>
<td>30</td>
</tr>
<tr>
<td>Using power plans</td>
<td>40</td>
</tr>
<tr>
<td>Creating a power plan</td>
<td>41</td>
</tr>
<tr>
<td>Changing power plan settings</td>
<td>41</td>
</tr>
<tr>
<td>Selecting a power plan</td>
<td>40</td>
</tr>
<tr>
<td>Setting up speech recognition</td>
<td>38</td>
</tr>
<tr>
<td>Rotating the display</td>
<td>36</td>
</tr>
<tr>
<td>Setting up an external display</td>
<td>36</td>
</tr>
<tr>
<td>Using the built-in microphones</td>
<td>37</td>
</tr>
<tr>
<td>Connecting headphones, external speakers, or a microphone</td>
<td>38</td>
</tr>
<tr>
<td>Using speech recognition</td>
<td>38</td>
</tr>
<tr>
<td>Setting up speech recognition</td>
<td>38</td>
</tr>
<tr>
<td>Using Dictation and Voice Commands</td>
<td>39</td>
</tr>
<tr>
<td>Using power plans</td>
<td>40</td>
</tr>
<tr>
<td>Selecting a power plan</td>
<td>40</td>
</tr>
<tr>
<td>Changing power plan settings</td>
<td>41</td>
</tr>
<tr>
<td>Creating a power plan</td>
<td>41</td>
</tr>
<tr>
<td>Using Sleep</td>
<td>41</td>
</tr>
<tr>
<td>Using Hibernate</td>
<td>42</td>
</tr>
<tr>
<td>Using the battery</td>
<td>43</td>
</tr>
<tr>
<td>Checking battery power</td>
<td>43</td>
</tr>
<tr>
<td>Charging the battery</td>
<td>45</td>
</tr>
<tr>
<td>Battery and power management tips</td>
<td>45</td>
</tr>
<tr>
<td>Removing and replacing the battery</td>
<td>46</td>
</tr>
<tr>
<td>Hot Swapping the battery</td>
<td>47</td>
</tr>
<tr>
<td>Battery maintenance</td>
<td>47</td>
</tr>
<tr>
<td>Long-term battery storage (not attached to tablet)</td>
<td>47</td>
</tr>
<tr>
<td>Disposing of used batteries</td>
<td>47</td>
</tr>
<tr>
<td>Removing and replacing the SIM</td>
<td>48</td>
</tr>
<tr>
<td>Using Motion OmniPass and the fingerprint reader</td>
<td>51</td>
</tr>
<tr>
<td>Capturing a fingerprint</td>
<td>51</td>
</tr>
<tr>
<td>Using password replacement</td>
<td>53</td>
</tr>
<tr>
<td>Using the password wizard</td>
<td>54</td>
</tr>
<tr>
<td>Logging on to a remembered site</td>
<td>54</td>
</tr>
<tr>
<td>Configuring authentication rules</td>
<td>54</td>
</tr>
<tr>
<td>Using Windows Security Center</td>
<td>55</td>
</tr>
<tr>
<td>Setting up users and passwords</td>
<td>56</td>
</tr>
<tr>
<td>Setting up Windows user accounts</td>
<td>56</td>
</tr>
<tr>
<td>Setting a BIOS password</td>
<td>56</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Setting up a hard disk drive (HDD) password</td>
<td>57</td>
</tr>
<tr>
<td>Using Wi-Fi (802.11a/g/n)</td>
<td>58</td>
</tr>
<tr>
<td>Enabling or disabling Wi-Fi</td>
<td>58</td>
</tr>
<tr>
<td>Setting up a Wi-Fi connection</td>
<td>58</td>
</tr>
<tr>
<td>Using Mobile Broadband (optional)</td>
<td>59</td>
</tr>
<tr>
<td>Activating your Mobile Broadband service</td>
<td>59</td>
</tr>
<tr>
<td>Enabling Mobile Broadband</td>
<td>59</td>
</tr>
<tr>
<td>Installing the connection manager</td>
<td>59</td>
</tr>
<tr>
<td>Connecting and disconnecting</td>
<td>59</td>
</tr>
<tr>
<td>Using Bluetooth (optional)</td>
<td>60</td>
</tr>
<tr>
<td>Enabling or disabling Bluetooth</td>
<td>60</td>
</tr>
<tr>
<td>Setting up a Bluetooth device</td>
<td>60</td>
</tr>
<tr>
<td>If the device is not discovered</td>
<td>61</td>
</tr>
<tr>
<td>Finding additional software</td>
<td>62</td>
</tr>
<tr>
<td>Chapter 4 Care and Maintenance</td>
<td>63</td>
</tr>
<tr>
<td>General care</td>
<td>63</td>
</tr>
<tr>
<td>Standard display</td>
<td>64</td>
</tr>
<tr>
<td>View Anywhere display (optional)</td>
<td>64</td>
</tr>
<tr>
<td>Cleaning in a health care environment</td>
<td>65</td>
</tr>
<tr>
<td>Disinfecting procedures</td>
<td>65</td>
</tr>
<tr>
<td>Training and documentation considerations</td>
<td>65</td>
</tr>
<tr>
<td>Cleaning solutions</td>
<td>65</td>
</tr>
<tr>
<td>Cleaning the fingerprint reader</td>
<td>66</td>
</tr>
<tr>
<td>Pen</td>
<td>67</td>
</tr>
<tr>
<td>Replacing pen tips</td>
<td>67</td>
</tr>
<tr>
<td>Ordering new pens</td>
<td>67</td>
</tr>
<tr>
<td>Traveling with your Tablet PC</td>
<td>68</td>
</tr>
<tr>
<td>Traveling by air</td>
<td>68</td>
</tr>
<tr>
<td>FAA Wireless air travel requirement</td>
<td>68</td>
</tr>
<tr>
<td>Creating a backup archive</td>
<td>69</td>
</tr>
<tr>
<td>Restoring data</td>
<td>69</td>
</tr>
<tr>
<td>Using Windows Recovery Environment</td>
<td>69</td>
</tr>
<tr>
<td>Using Windows 7 to restore individual files</td>
<td>70</td>
</tr>
</tbody>
</table>
Appendix A Troubleshooting and Support......... 71

Troubleshooting .......................................................... 71
Power .............................................................................. 71
Battery .......................................................................... 72
Display .......................................................................... 72
Input .............................................................................. 73
Ports and connectors ..................................................... 74
Network ......................................................................... 74
Audio ............................................................................. 75
System ........................................................................... 75
Frequently asked questions ........................................... 76
Specifications .................................................................. 77
Warranty and Insurance Programs ................................. 77
Service and Support ....................................................... 77

Index .............................................................................. 79
The Motion Computing® J3400 is a full-featured Tablet PC, combining performance, long battery life, and a lightweight, sleek design. The J3400 offers the latest innovations in mobile computing: a user-focused design, unmatched mobility, and state-of-the-art security.

If you are new to Tablet PCs, use the information in this section to get started quickly. If you are already familiar with tablet computers, you can skip to the next chapter to learn about the features of the J3400. If there are certain things you want to learn about your new Tablet PC, look on the Contents page.

Finding information
If you are viewing this PDF document on your screen, you can use the following methods to find information:

- In the Bookmark pane, click or tap a topic to view it. If the Bookmark pane is not visible, select View > Navigation Tabs > Bookmarks.
- On the Contents page, click or tap a topic to view it.
- To search the document, select Edit > Find.

Because you typically use a tablet pen instead of a mouse with a Tablet PC, we use the term tap instead of click in most situations.
Overview
The following illustrations show the buttons, slots, and ports on the Motion J3400 Tablet PC.

**Front View**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speakers</td>
<td>Listen to music or other audio.</td>
</tr>
<tr>
<td>Microphones</td>
<td>Record sounds and use for speech recognition.</td>
</tr>
<tr>
<td>Ambient light sensor</td>
<td>Measures background light and can automatically adjust the display brightness.</td>
</tr>
<tr>
<td>Camera shutter</td>
<td>Use to trigger the integrated camera.</td>
</tr>
<tr>
<td>Motion QuickNav™</td>
<td>Use to open the Motion QuickNav</td>
</tr>
<tr>
<td>Dashboard button</td>
<td>Open Motion Dashboard.</td>
</tr>
<tr>
<td>Esc button</td>
<td>Cancel the current task. Equivalent to the Esc key on a keyboard.</td>
</tr>
<tr>
<td>Directional pad</td>
<td>Use for basic navigation. Equivalent to the arrow keys on a keyboard. The center button is equivalent to Enter.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FlexDock connector</td>
<td>Connects to the FlexDock when docked. (Note: remove the cover before attaching the J3400 to the dock)</td>
</tr>
<tr>
<td>Battery power indicator lights</td>
<td>Indicates amount of remaining battery power.</td>
</tr>
<tr>
<td>Battery</td>
<td>Powers the tablet when it is not plugged in or docked.</td>
</tr>
<tr>
<td>Battery gauge button</td>
<td>Press the button to show remaining power on the indicator lights.</td>
</tr>
<tr>
<td>Battery release switch</td>
<td>Slide to release and remove the battery.</td>
</tr>
<tr>
<td>Camera lens</td>
<td>Capture images to the hard disk drive.</td>
</tr>
<tr>
<td>Camera light</td>
<td>Provides light for the integrated camera.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Shoulder strap attach point</td>
<td>Attach point for the shoulder strap.</td>
</tr>
<tr>
<td>Air vent</td>
<td>Dissipates heat from the tablet.</td>
</tr>
<tr>
<td>Battery status light</td>
<td>Indicates amount of remaining battery power.</td>
</tr>
<tr>
<td>Windows Security button</td>
<td>Use to log on to or lock your tablet. Equivalent to Ctrl+Alt+Del on a keyboard.</td>
</tr>
<tr>
<td>Fingerprint reader</td>
<td>Scan your fingerprints for added security. You can also use the fingerprint reader as a navigation device.</td>
</tr>
<tr>
<td>power button</td>
<td>Turns the Tablet PC on and off.</td>
</tr>
<tr>
<td>Card slots cover</td>
<td>Covers the smart and Express card slots.</td>
</tr>
<tr>
<td>Smart card slot</td>
<td>Attach a smart card.</td>
</tr>
<tr>
<td>Express card slot</td>
<td>Attach an Express card.</td>
</tr>
<tr>
<td>Pen and pen bay</td>
<td>Store the pen when not in use.</td>
</tr>
<tr>
<td>Pen tether attach point</td>
<td>Attach point for the pen tether.</td>
</tr>
</tbody>
</table>
### Left Side

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security slot</td>
<td>Connect a security cable to protect your tablet from theft.</td>
</tr>
<tr>
<td>Air vent</td>
<td>Dissipates heat from the tablet.</td>
</tr>
<tr>
<td>Audio in/Microphone port</td>
<td>Connect a microphone or other audio source using a 3.5 mm jack.</td>
</tr>
<tr>
<td>Audio out/Headphone port</td>
<td>Connect headphones, speakers, or audio equipment using a 3.5 mm jack.</td>
</tr>
<tr>
<td>Ethernet port</td>
<td>Connect to a 10/100/1000 Ethernet network.</td>
</tr>
<tr>
<td>Port covers</td>
<td>Covers the two sets of ports.</td>
</tr>
<tr>
<td>USB 2.0 ports</td>
<td>Connect USB devices such as a mouse, digital camera, printer, or external storage device.</td>
</tr>
<tr>
<td>Video (VGA) port</td>
<td>Connect an external monitor using the standard DB-15 VGA connector.</td>
</tr>
<tr>
<td>Power adapter port</td>
<td>Connect the power adapter.</td>
</tr>
<tr>
<td>Shoulder strap attach point</td>
<td>Attach point for the shoulder strap.</td>
</tr>
</tbody>
</table>

### Bottom View

- Docking port
Setting up the J3400
The J3400 is self-contained, so you can start using it immediately. You should connect AC power until the battery is fully charged. Use the following steps to get started:

Step 1: Plug in the power adapter
- Plug the power cord into the power adapter and the tablet, then plug the power cord into an outlet.

Step 2: Connect the cables
- If you want to connect your Tablet PC to a network, insert an Ethernet cable into the Ethernet port.

To connect to a wireless network, see “Using Wi-Fi (802.11a/g/n)” on page 58. To connect using docking stations and other accessories, refer to the documentation for that product.
Step 3: Turn on the Tablet PC

- Press the power button.

Windows 7 starts and the Welcome screen displays.

Step 4: Calibrate the digitizer

With a Tablet PC, you frequently use a tablet pen instead of a mouse and keyboard for input. Use the pen to move the pointer around the screen, and tap the screen to click. Use Tablet PC Input Panel and handwriting recognition to enter text.

The digitizer detects the position of the pen on the display. You should calibrate the digitizer the first time you start the Tablet PC, and again whenever the pointer does not align with the pen tip.

To calibrate the digitizer

1. Press the Dashboard button ( ) to start Motion Dashboard.

   You can use Motion Dashboard to configure your Tablet PC and to start commonly used tablet applications. See “Using Motion Dashboard” on page 26.

2. Under Pen & Tablet, tap Calibrate Digitizer.

3. Follow the instructions in the calibration program.

   Note: If you are left-handed, see “How do I adjust the Tablet PC for left-handed use?” on page 77.

Step 5: Get familiar with your Tablet PC

Motion Computing offers free Web-based Quick Start Training that you can use to familiarize yourself with the features of your Tablet PC. If you are new to tablet computing, you can use the training to get started quickly. You can find the training at http://training.motioncomputing.com/products/training_online_resources.asp.

You can use the personalize handwriting recognition tool to familiarize the Tablet PC with your handwriting.

To access the tool, select Start > All Programs > Accessories > Tablet PC > Personalize Handwriting.
The Motion Computing J3400 Tablet PC has the power and features of a notebook computer, while giving you the added mobility and versatility of a tablet computer.

Use the information in this chapter to get more familiar with the hardware features of your J3400 Tablet PC, such as buttons, slots, connectors, and wireless adapters.

The J3400 Tablet PC includes the following integrated features:

• Intel® Core™2 Duo Processor
• Mobile Intel® GS45 Express Chipset
• Wi-Fi® (802.11a/g/n) networking
• Bluetooth® (optional)
• Mobile Broadband (optional)
• DataGuard™ to help protect the hard drive
• DDR3 RAM
• 12.1” diagonal TFT LCD WXGA
• Fingerprint reader
• Gigabit Ethernet
• Motion QuickNav
Pen

An important difference between traditional PCs and Tablet PCs is that you frequently use the tablet pen to interact with the computer instead of a mouse and keyboard. The pen includes a pressure-sensitive tip, a function button and an eraser. The pen contains no batteries and requires no external power.

For information about using the pen, see “Using the pen” on page 28.
Front panel buttons
You can use the buttons on the front of the tablet to perform many functions without having to use the pen. The buttons are customizable, so you can modify their functions to suit the way you work. See “Configuring front panel buttons” on page 30.

<table>
<thead>
<tr>
<th>Button</th>
<th>Primary</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera shutter</td>
<td>Use to trigger an exposure in the built-in camera.</td>
<td>Opens Windows Photo Gallery.</td>
</tr>
<tr>
<td>Motion QuickNav</td>
<td>Opens QuickNav.</td>
<td>Opens Motion QuickNav Voice Recorder.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Starts Motion Dashboard.</td>
<td></td>
</tr>
<tr>
<td>Esc</td>
<td>Cancels the current task. Equivalent to the Esc key.</td>
<td></td>
</tr>
<tr>
<td>Directional pad</td>
<td>Use to move the pointer or navigate through documents. Equivalent to arrow keys on a keyboard. The center button is equivalent to Enter.</td>
<td></td>
</tr>
</tbody>
</table>

The directional pad orientation rotates to match the display orientation. To move the pointer in a certain direction, press that direction on the pad regardless of orientation. For example, the “up” direction in landscape orientation becomes the “left” direction in portrait orientation.
Battery status light

You can use the indicator light on the right side of the tablet to monitor the status of the battery. The following illustration and table show the battery status light and the various power state descriptions.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady green</td>
<td>The battery is fully charged and the tablet is running on AC power</td>
</tr>
<tr>
<td>Steady amber</td>
<td>One or more batteries charging</td>
</tr>
<tr>
<td>Off</td>
<td>Not charging. The tablet is running on battery power.</td>
</tr>
<tr>
<td>Flashing amber (slow)</td>
<td>Less than 10% charge remaining</td>
</tr>
<tr>
<td>Flashing amber (fast)</td>
<td>Less than 5% charge remaining</td>
</tr>
</tbody>
</table>
Motion QuickNav

Motion QuickNav provides a Windows 7 interface for entering text, taking pictures with Geo Tag, doing voice recordings, and other features. You can create shortcut keys to launch applications you use most often. QuickNav provides three different keyboard or input styles for easier data input in the environment you are working.

For more information, see “Using Motion QuickNav” on page 31.
Camera
You can use the built-in 2-megapixel auto-focus camera to take pictures and save them to the hard disk drive. The camera lens is on the back of the unit, and includes a light to illuminate the subject. The camera produces pictures in JPG format with a resolution up to 1600 × 1200 pixels.

The following table shows detailed specifications for the camera.

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensor array</td>
<td>CMOS sensor 2.0 megapixel</td>
</tr>
<tr>
<td>Pixel size</td>
<td>2.2μm x 2.2μm</td>
</tr>
<tr>
<td>Optical format</td>
<td>1/4&quot;</td>
</tr>
<tr>
<td>S/N ratio</td>
<td>40dB</td>
</tr>
<tr>
<td>F number</td>
<td>2.8</td>
</tr>
<tr>
<td>Focus</td>
<td>Auto focus @ 10cm ~ infinity</td>
</tr>
<tr>
<td>Image resolution</td>
<td>Up to 2M Pixel</td>
</tr>
<tr>
<td>Frame rate</td>
<td>20 - 30 FPS</td>
</tr>
<tr>
<td>White balance</td>
<td>Automatic</td>
</tr>
<tr>
<td>Exposure</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

For information about using the camera, see “Using the camera” on page 32.
Security
The J3400 provides a safe computing environment that enables strong security protection and serves as the foundation for complementary security technologies.

The core security features include InsydeH2O™ Extensible Firmware Interface (EFI) BIOS, a built-in fingerprint reader, a universal security lock, the Dashboard Security Center, TPM (Trusted Platform Module), and a Smart Card-ready platform.

With the built-in TPM and Infineon Security Platform Tools, you can create and manage digital certificates for user and platform authentication. These features are most commonly used by enterprises and enabled by the system administrator. To download and install the TPM, go to http://www.motioncomputing.com/support/driver_download.asp, select the link to the operating system for your Tablet PC, then scroll down to (TPM) Trusted Platform Module Software.

Windows Security button
Pressing the Windows Security button is equivalent to pressing Ctrl+Alt+Del on a keyboard. You can use the Windows Security button to log on to or lock your Tablet PC.
Fingerprint reader

Using the fingerprint reader, you can log on to your Tablet PC by scanning your fingerprint instead of entering a password. This presents an added level of security for your tablet.

You can use the OmniPass™ application to associate your fingerprint with passwords for Web pages and other applications. You can also use the fingerprint reader as a scrolling device. Move your finger on the fingerprint reader to move the pointer on the screen.

Note: The scroll function is disabled while scanning a fingerprint.

For information about setting up and using the fingerprint reader, see “Capturing a fingerprint” on page 51.

Display

The J3400 includes a 12.1-inch display with the following features:

• A highly readable LCD (liquid crystal display).
• WXGA, 1280 x 800 resolution.
• A protective layer that offers a firm writing surface and minimizes glare.
• A digitizer panel that enables handwritten entry and windows navigation with the tablet pen.
View Anywhere display (optional)
The View Anywhere™ display option enhances outdoor viewing and bright-light viewing environments. The View Anywhere display includes all the features of the standard display plus:

- A protective layer that improves the sunlight contrast ratio and significantly reduces reflection and glare.
- Improved sunlight contrast ratio, which enhances viewability at wide viewing angles.
- Reduced reflection and glare and improved light pass-through efficiency.

Microphones
The J3400 is equipped with integrated microphones that you can use to record audio, dictate notes, and use voice commands without the need for an external microphone.

You can also use the microphone port to connect an external microphone or microphone headset. See “Connecting headphones, external speakers, or a microphone” on page 38.

Speakers
The J3400 is equipped with integrated stereo speakers that you can use to listen to music, movies, or other multimedia applications.

You can also use the headphones port to connect external speakers or headphones. See “Connecting headphones, external speakers, or a microphone” on page 38.

Ambient light sensor (ALS)
If you have dynamic brightness selected and are running on battery power, the ambient light sensor measures the surrounding light and adjusts the display brightness and contrast accordingly. This ensures that you have proper settings for all lighting conditions. To enable dynamic brightness, see “Adjusting the display brightness” on page 35.

Motion DataGuard
For J3400 tablets using a hard disk drive (spinning media), the DataGuard feature is included, which detects shocks, extreme vibrations, and falls. If these conditions are detected, DataGuard moves the drive heads away from the disk, which can prevent hard drive failures and data loss. For more information, go to Control Panel, enter “dataguard” in the Search Control Panel field, then open DataGuard.
USB 2.0 ports
Two USB 2.0 (High-speed USB) ports can be used to attach any USB device such as a mouse, digital camera, printer, or external storage device. The USB ports are compatible with older USB devices (USB 1.1).

For more information, see “Using USB” on page 32.

Headphones port
The headphones port is on the left edge of the Tablet PC. It is marked with a small headphones symbol and is designed as an audio output channel only. You can attach headphones or external speakers to this port.

For more information, see “Connecting headphones, external speakers, or a microphone” on page 38.

Microphone port
The microphone port is on the left edge of the Tablet PC. It is marked with a small microphone symbol and is designed as an audio input/line in channel only. You can attach an external microphone directly to this port to enhance your audio recording capabilities.
The internal microphones are disabled when an external microphone is attached.

For more information, see “Connecting headphones, external speakers, or a microphone” on page 38.
Security slot
You can use the security slot to attach your tablet to a desk, table or other fixture. You must purchase a security lock separately.

VGA port
You can use the VGA port to connect standard VGA monitors. When you attach an external monitor, you can use the external monitor only, or the external monitor and the Tablet PC display together. See “Setting up an external display” on page 36.

Ethernet port
The J3400 comes with an integrated 10/100/1000 Base-T Ethernet port (RJ-45), which you can use to connect to an Ethernet network or another computer.

For more information, see “Using Ethernet” on page 32.

Docking connector
The J3400 has a docking port that you can use to connect the tablet to the Motion FlexDock. When the tablet is connected to the FlexDock, the port connections are replicated on the dock. This enables you to connect a monitor, keyboard, mouse, or external drive to the dock and easily dock and undock the tablet. For more information about the FlexDock and other accessories, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

Smart card reader slot (optional)
Your tablet includes a smart card reader located on the right side of the tablet, under the card slots cover, next to the pen bay. Using smart card software, this device can read information from and write information to the smart card when the card is inserted into the slot. The smart card is an ISO 7816 PC/SC compliant, contact type smart card reader/writer.

For information about using the smart card reader, see “Using the smart card reader (optional)” on page 34.
Express card slot (optional)
The Express card slot holds one Express card for networking, memory expansion, or accessories.

- To insert an Express card, remove the card slot cover and place the Express card in the slot with the label side up.
- To remove the card, pull the card out of the slot and replace the card slot cover.

The J3400 includes a cover for the Express card slot. To protect the Express card slot, you should leave the cover in place when you do not have an Express card in the slot.

For information about using the Express card reader, see “Using the Express card reader (optional)” on page 35.

SIM slot
The SIM slot holds one SIM (Subscriber Identity Module). A SIM is a smart card, about the size of a postage stamp, that stores information about your wireless account.

You need to use a SIM only if you are using Mobile Broadband on an HSDPA (High Speed Downlink Packet Access) network. Contact your service provider for details.

For information about removing and replacing the SIM, see “Removing and replacing the SIM” on page 48.

Wi-Fi (802.11a/g/n wireless)
Your Tablet PC has integrated Wi-Fi (802.11a/g/n) that you can use to connect to the Internet and other computers wirelessly. You can use Wi-Fi in your home, and in many schools, hotels, airports, and restaurants.

*Note:* Wireless access requires an 802.11a, 802.11g, or 802.11n access point. Internet access requires a working Internet connection.

Your ability to use Wi-Fi depends on the several conditions:
- Distance from the access point.
- Ability to connect to the access point.
- Access rights (which may require an account fee, user name, password, an/or network set up through an administrator).
- Security settings, such as whether the network broadcasts a network name or uses encryption.

For more information, see “Using Wi-Fi (802.11a/g/n)” on page 58.
Mobile Broadband (optional)
The J3400 Tablet PC is available with an optional Mobile Broadband adapter that you can use to send and receive data wirelessly. By using Mobile Broadband, you can browse the Internet, send and receive email, connect to your company’s intranet, or use Web-based applications.

Mobile Broadband is based on cellular network technology, so you can use it in more places than other wireless technologies. With Mobile Broadband, your Tablet PC connects to a service provider’s base station, which in turn is connected to the Internet. Unlike Wi-Fi, you do not need to search for Wi-Fi hotspots or buy base stations. You can typically use Mobile Broadband anywhere you can use your mobile phone. For more information, see “Using Mobile Broadband (optional)” on page 59.

Bluetooth wireless (optional)
Your Tablet PC has an integrated Bluetooth adapter. With Bluetooth, computers and other devices—such as mice, keyboards, cameras, and PDAs—can be interconnected using a short-range wireless connection. Bluetooth devices can connect wirelessly at distances up to 33 feet (10 meters).

For more information, see “Using Bluetooth (optional)” on page 60.

Power adapter
The power adapter provides power to the Tablet PC and charges the battery when it is in the Tablet PC.

**WARNING:** Use only the Motion approved power adapter with your Motion Tablet PC. Do not use the adapter to power any other electronic devices. Using the Motion approved power adapter to power other devices can damage the power adapter or other devices. Using a non-Motion approved power adapter can damage the Tablet PC.
Battery
The J3400 includes two battery bays for containing up to two high-capacity Lithium-ion batteries that are installed on the back of the Tablet PC.

If only one battery is included with the tablet, a battery bay cartridge (non-functioning) is included for occupying the second battery bay. Do not discard the battery bay cartridge. If your battery or spare battery becomes damaged and is being replaced by Motion, the battery bay cartridge must remain installed in the battery bay to prevent foreign objects falling into the battery bay.

Under normal conditions, you can run the tablet on battery power with one battery for about three hours and using two batteries for about seven hours. You can maximize battery life by optimizing your power plan. See “Using power plans” on page 40.

For information about charging and checking battery status, see “Using the battery” on page 43.

CAUTION: To avoid personal injury, handle the battery with care. Do not open, puncture, short, or expose it to fire or water. Keep the battery in an ambient temperature of less than +104°F (+40°C). For example, do not leave the battery in a closed car in hot weather for an extended time. For more information, see the Safety and Regulatory Guide included with your Tablet PC.

J-Series FlexDock (optional)
The J-Series FlexDock provides a docking tray and ports for connecting the J3400 Tablet PC to the following devices:

• AC power for charging the J3400 Tablet PC and battery.
• USB devices (four ports)
• Display
• Ethernet
• VGA
• Microphone
• Headphone

The FlexDock includes the following features:

• A battery charger for charging the battery.
• The viewing angle of the FlexDock can be adjusted for optimum viewing of an attached J3400 tablet.
• The FlexDock tray can be removed from the base and mounted on a mounting device or stand containing a VESA screw-hole pattern.

For more information about using the J-Series FlexDock, see the J-Series FlexDock User’s Guide shipped with your FlexDock.
J-Series Mobile Keyboard (optional)

The J-Series Mobile Keyboard is a thin-profile, portable, full size keyboard solution for entering data in the J-Series Tablet PC.

When in the closed position, the Mobile Keyboard has a thin profile and can be attached to the back of the J-Series Tablet PC for easy transporting. When opened, the Mobile Keyboard provides a stable docking tray for mounting the J-Series Tablet PC and a full size keyboard for easy data entry.

The Mobile Keyboard has a trackpad that can be temporarily turned off. The trackpad is on by default. It will be turned on when either the tablet is placed onto the keyboard or when the tablet and keyboard are first powered on.

Press the Function key and the F1 key simultaneously to turn off the Trackpad and its associated buttons.

Press the Function key and the F2 key simultaneously to turn on the Trackpad and its associated buttons.

For more information about using the J-Series Mobile Keyboard, refer to the J-Series Mobile Keyboard User’s Guide included with your Mobile Keyboard.
The J3400 Tablet PC runs the Microsoft Windows® 7 operating system, which includes ink-to-text and handwriting recognition, voice recognition, and improved security to help defend against viruses, worms, and other threats. And unlike PDAs or other handheld devices, the J3400 can run any Windows 7-compatible application.

Use the information in this chapter to learn about common tasks such as using the tablet pen to enter text, using Motion Dashboard, using speech recognition, and customizing the tablet to fit the way you work.
Using Motion Dashboard
Motion Dashboard puts many common tablet-related settings and tasks at your fingertips. For example, you can enable or disable Bluetooth and Wi-Fi, calibrate the digitizer, or check your remaining battery power.

To start Motion Dashboard

• Press the Dashboard button ( ) on the front of the tablet.

When you change a setting on Motion Dashboard, the change occurs immediately. You do not need to tap Apply or OK.

For more information, see Motion Dashboard Help.
Using the Motion utility in the notification area

Click the Motion utility icon ( ) in the notification area ( ). You may need to click the up arrow ( ) to view the icon.

You can access the following features from the Motion utility icon:

- **Battery Health**
  Selecting this option opens a window that shows information about correct battery conditioning to prolong the life of the battery and shows the current battery charge level.

- **Motion Dashboard**
  Selecting this option opens the Motion Dashboard.

- **Motion DataGuard**
  This option opens the Motion DataGuard, if it is included on your tablet PC.

  *Note:* Motion DataGuard is included on J3400 Tablet PCs using a hard disk drive (spinning media).

- **Options**
  Selecting this option opens another window to select the following options:
  
  - **Show Hard Drive Activity** - When this option is selected, the Motion utility icon blinks when there is hard drive activity.
  
  - **Automatic Display Rotation** - When this option is selected, the tablet automatically changes viewing orientation (landscape to portrait or vice versa) when the tablet is physically rotated.
Using the pen

You can use the tablet pen to write on the display and navigate the operating system. A pen can feel more natural in your hand than a mouse, and you can use the pen while standing or walking. The following table show the various pen actions and their mouse equivalents.

<table>
<thead>
<tr>
<th>Mouse action</th>
<th>Pen equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Point</td>
</tr>
<tr>
<td>Click</td>
<td>Tap</td>
</tr>
<tr>
<td>Double-click</td>
<td>Double-tap</td>
</tr>
<tr>
<td>Drag</td>
<td>Drag</td>
</tr>
<tr>
<td>Right-click</td>
<td>Tap and hold</td>
</tr>
<tr>
<td>Right-click</td>
<td>Press pen Function button and then tap</td>
</tr>
</tbody>
</table>

Some software applications, such as Microsoft Word, support ink drawing and ink annotations. Some applications such as art or drawing programs are designed especially for ink input. For more information about a particular application, open the application help and search for “pen”, “ink”, or “tablet”.

You can use Tablet PC Input Panel instead of a keyboard to enter text. For more information, see “Using Tablet PC Input Panel” on page 29.

Store the pen in the pen bay when not in use. To store the pen in the pen bay, insert it into the bay and press it until it clicks. To remove the pen, press it again. If you have the pen tether attached, ensure that you have released the pen before you pull it out using the tether.

The pen includes extra tips. You can use the included replacement tool to change the tips. See “Replacing pen tips” on page 67.

**Important:** The Tablet PC responds only to the tablet pen. Do not use traditional pens or other pointing devices with the Tablet PC.
Using Tablet PC Input Panel
You can use Tablet PC Input Panel instead of a keyboard to enter text on your Tablet PC. Use the writing pad or the character pad to convert your handwriting to text, or tap characters using the on-screen keyboard.

The following illustration shows Input Panel open to the writing pad.

![Input Panel Illustration]

To start Input Panel
• Do one of the following:
  – Tap at the place you want to enter text, such as a text box. Then tap the Tablet PC Input Panel icon ( ).
  – Tap the Input Panel tab on the left edge of the screen (default).

To switch between the writing pad and the on-screen keyboard, tap the appropriate button.

To switch to the character pad, tap Tools, then Write character by character.

For a demonstration, tap the help icon, then tap the topic you would like to see demonstrated.

For more information about using Input Panel, tap Tools, then Help Topics.

Configuring pen options
You can use pen options to enable or disable the pen function button and the pen eraser.

To configure pen options
1. Open Motion Dashboard to the Pen & Tablet panel (page 26).
2. Tap the Pen & Input Devices button.
3. In the Pen and Touch window, tap the Pen Options tab.
4. For pen buttons, do one or more of the following:
   • To enable the pen button, select Use pen button as a right-click equivalent.
   • To enable the eraser, select Use top of pen to erase ink (where available).
Using personalized handwriting recognition
You can use personalized handwriting recognition to improve your handwriting results.

To use personalized handwriting recognition
1. Tap Start > All Programs > Accessories > Tablet PC > Personalize Handwriting.
2. Follow the instructions in the handwriting personalization tool.

Configuring front panel buttons
As you become more familiar with your Tablet PC, you may want to customize the buttons on the front panel. You can configure the buttons to start your favorite program, run a command, or enter a key combination.

Configuring front panel buttons

To change the front panel buttons
1. Open Motion Dashboard to the Pen & Tablet panel (page 26).
2. Tap the Tablet PC Settings button.
3. In the Tablet PC Settings window, tap the Buttons tab.
4. Select the button combination you want to change. The currently selected buttons appear in red.
5. Tap Change.
6. Select the appropriate action for the button.

For some actions, you must enter more information, such as the location of a program to start. You can select an action for Press and another for Press and hold. For more information, tap What is press and hold?
Using Motion QuickNav

Motion QuickNav provides multiple QWERTY keyboard lay-outs and numeric pads for quickly entering text, numbers, and symbols into documents and applications. It also lets you quickly take a picture using the camera, record or play back a voice note, and acquire a GPS location.

To start Motion QuickNav

Do one of the following:

- Press the Motion QuickNav quick-launch button ( ).
- Go to Start -> All Programs-> Motion QuickNav, then click Motion QuickNav.

The following illustration shows Motion QuickNav in its default location on the right side of the tablet PC’s screen:

Tap the buttons to open QuickNav’s various features. For example, tapping the top buttons opens one of QuickNav’s keyboard lay-outs.

For more information on using QuickNav, tap QuickNav’s help button to view the Motion QuickNav online help.

Note: Once Motion QuickNav has been launched, you can tap on the QuickNav icon ( ) in the system tray and configure your desired options.
You can also access QuickNav features from some of the Tablet PC's hardware buttons. The following table shows the hardware buttons and which QuickNav features they launch.

<table>
<thead>
<tr>
<th>Primary (Press)</th>
<th>Secondary (Press and hold button for one second)</th>
</tr>
</thead>
<tbody>
<tr>
<td>📸</td>
<td>Lets you quickly take a picture. Starts My Pictures.</td>
</tr>
<tr>
<td>🎤</td>
<td>Lets you quickly open QuickNav. Starts a voice note.</td>
</tr>
</tbody>
</table>

Using USB
You can use the two integrated USB 2.0 ports to connect USB devices, such as digital cameras, printers, external storage devices, keyboards, and mice. USB devices typically use power from the computer, so you should use AC power or have adequate battery power while you are using USB devices.

To use a USB device, connect the device to the USB port (鳝) on the side of the Tablet PC.

When you connect a USB device, the Tablet PC recognizes it and loads the appropriate device driver. You can connect and disconnect USB devices without shutting down your computer.

Using Ethernet
You can use the integrated 10/100/1000 Base-T Ethernet port (RJ-45) to connect to an Ethernet network, high-speed modem, or another computer.

To connect to an Ethernet network or device, connect the Ethernet cable to the Ethernet port (鳝鳝) on the left side of the Tablet PC.

Using the camera
You can use the built-in camera to take pictures. For more information about the camera, see “Camera” on page 14.

To use the camera
1. Open Motion QuickNav. (See “Using Motion QuickNav” on page 31.)
2. Press the Camera button to activate the camera and open the viewfinder.
Note: If a picture is not taken after a short period, the viewfinder will automatically close. If this occurs, repeat the steps.

3. Press the Camera button again to take a picture.

4. In the Pictures window, do one of the following:
   • To close the Pictures window, tap anywhere outside of the QuickNav window.
   • Pictures are automatically saved in the My Pictures folder, located in the My Documents folder.

Camera tips
   • Hold the camera steady and allow it to focus.
   • If your pen is tethered, ensure that the tether is not in front of the camera lens.
   • Ensure you have adequate lighting.
   • You can use the Pictures window to take and review multiple pictures. Use the slider bar at the bottom of the Pictures window to switch among active pictures.
Using the smart card reader (optional)

Some tablets contain the optional smart card reader. Using smart card software, this device reads information from the smart card when the card is inserted into the reader.

Depending on the smart card software you are using:

• You may receive an acknowledgement for when the smart card is fully engaged in the reader.
• You may receive a prompt or be required to shut down the software before removing the smart card.
• Some smart cards may require you to insert the smart card for authentication, and then remove the smart card when authentication is completed.
• Some smart cards may require keeping the card in the reader while the smart card software is running.

To insert the smart card
1. Remove the card slots cover.
2. Slide the smart card into the slot, with the metal contacts of the embedded chip facing the top of the tablet, until the card is firmly seated in the reader.

To remove the smart card
1. Depending on your smart card software, you may be required to first shut down the smart card software before removing the card. With this type of software, removing the smart card while the tablet is running can result in logging off or shutting down the tablet.
2. Pull the card straight out of the reader and replace the card slots cover.
Using the Express card reader (optional)
The Express card slot holds one Express card for networking, memory expansion, or accessories.

- To insert an Express card, remove the card slot cover and place the Express card in the slot with the label side up.
- To remove the card, pull the card out of the slot and replace the card slot cover.

The J3400 includes a cover for the Express card slot. To protect the Express card slot, you should leave the cover in place when you do not have an Express card in the slot.

Using the display
Use the procedures in this section to customize your display settings. You can adjust the brightness level, rotate the display, and change the order in which the display rotates.

Adjusting the display brightness
Use this procedure to change the brightness of the display.

**To adjust the display brightness**
1. Open Motion Dashboard to the Display panel (page 26).
2. Set the Brightness slider to the appropriate level.

   For optimal battery conservation and viewability, set the brightness scale to the midpoint or slightly above.
3. Select one of the following:
   - **Fixed.** Sets the display brightness to a constant level. Use the slider to adjust the display to the desired brightness level. The ambient light sensor is not used with fixed brightness.
   - **Dynamic.** Uses the ambient light sensor to maintain an appropriate brightness level for the current lighting conditions. Using dynamic brightness helps to reduce power consumption while running on battery power.
Rotating the display
You can easily change the screen orientation to fit your current task. You may want to use the portrait orientation for filling out forms or reading an e-book. At other times, you may want a landscape orientation for Web browsing or sketching.

To rotate the display
1. Open Motion Dashboard to the Display panel (page 26).
2. Tap the Rotate Screen button.

Note: If you change the screen orientation, you may need to recalibrate the tablet pen. See “Calibrate the digitizer” on page 7.

Setting up an external display
If you want more space on the desktop, or the flexibility of multiple monitors, you can connect an external display, such as a monitor or projector.

You can extend your display to the external monitor, mirror your display on the external monitor, or use the external monitor only. Because the tablet pen does not work on the external display, you should typically use a keyboard and mouse when you have an external display attached.

To set up an external monitor
1. Connect the monitor cable into the appropriate display port on the FlexDock. Use the VGA port to connect to the external monitor.
2. Plug in the external monitor and turn it on.
3. If necessary, install software and drivers for the monitor. See the manufacturer’s documentation for more information.
4. Open Motion Dashboard to the Display panel (page 26).
5. For **Display Scheme**, select one of the following:

- **Mirror Display**. Duplicates the Tablet PC display on the external monitor or projector. The same desktop is visible on both displays. The external monitor must use the same display resolution as the Tablet PC.

- **Extended with Monitor Primary**. Enlarges the desktop area to include the external monitor as the primary monitor. The external monitor can use a different display resolution than the Tablet PC.

- **Extended with Tablet Primary**. Enlarges the desktop area to include the external monitor as the secondary monitor. The external monitor can use a different display resolution than the Tablet PC.

- **Monitor Only**. Uses the external monitor only.

- **Tablet Only**. Uses the Tablet PC display only.

To learn more about custom monitor schemes, go to [www.motioncomputing.com/tips](http://www.motioncomputing.com/tips).

### Using the built-in microphones

You can use the built-in array microphones to record audio, dictate notes, and use voice commands. The two microphones are used at the same time to optimize sound detection for speech recognition and voice recording.
Connecting headphones, external speakers, or a microphone
You can connect headphones or external speakers to the headphones port using a 3.5 mm plug. When speakers or headphones are connected, the internal speakers are disabled.

You can connect an external microphone or headset to the microphone port using a 3.5 mm plug. When a microphone is connected, the internal microphones are disabled.

Using speech recognition
You can use speech recognition to interact with your Tablet PC by voice. You can dictate documents and emails, or use voice commands to control programs.

• **Dictation mode.** With Dictation mode, your computer listens to everything you say and converts your words to text. You can use dictation mode to enter text directly into any document or text box.

• **Voice command mode.** With Voice command mode, your computer listens for specific words that correspond to a list of available voice commands. You can use commands to switch between programs, save documents, copy, paste, or undo.

Setting up speech recognition
Before you can use speech recognition, you must configure the microphones and train the system for the characteristics of your voice. You can also take the speech tutorial to learn how to talk to your computer.

**Setting up the microphones**
For best results, move to a quiet environment.

**To set up the microphones**
1. In Control Panel, tap the **Ease of Access** category, then tap **Speech Recognition**.
2. Tap **Set up microphone**.
3. If you are using the integrated Tablet PC microphone array, select **Other**.
4. Follow the instructions in the setup program.

If the microphones are set to an appropriate level, the meter will stay in the green zone while you read the sentences. If the level is too low or too high, use Motion Dashboard to adjust the level (page 26).
Train your computer to recognize your speech
Use this procedure to improve your computer’s ability to understand your voice.

**To train your computer to recognize your speech**
1. In Control Panel, tap the *Ease of Access* category, then tap *Speech Recognition*.
2. Tap *Train your computer to better understand you*.
3. Follow the instructions in the setup program.

**Taking the Speech Tutorial**
You can use the Speech Tutorial to learn basic commands and dictation. The Speech Tutorial takes about 30 minutes to complete.

**To take the speech tutorial**
1. In Control Panel, tap the *Ease of Access* category, then tap *Speech Recognition*.
2. Tap *Take Speech Tutorial*.
3. Follow the instructions in the tutorial program.

**Using Dictation and Voice Commands**
After you have set up speech recognition, you can start it from Control Panel.

**To use Dictation and Voice Commands**
1. In Control Panel, tap the *Ease of Access* category, then tap *Speech Recognition*.
2. Tap *Start Speech Recognition*.
3. Ensure that the Speech Recognition window is open and listening.

4. Do one of the following:
   - For voice commands, say the appropriate command. For a list of commands, search Windows Help and Support for “speech commands”.
   - For dictation, open the program you want to use and start speaking.

For more information about speech recognition, search Windows Help and Support for “speech recognition”.

Chapter 3  Using your Tablet PC
Using power plans
The J3400 includes a comprehensive suite of power management functions. By using power plans, you can maximize system performance, save energy, or get the most from a single charge.

Selecting a power plan
Use this procedure to choose among the Balanced, Power saver, or High performance power plans.

To select a power plan
1. Open Motion Dashboard to the Power panel (page 26).
2. Tap the **Power Options** button.
3. On the Power Options page, select a power plan.

For information about creating a custom power plan, see “Creating a power plan” on page 41.
Changing power plan settings
You can edit the particular settings of an existing power plan. To create your own power plan, see “Creating a power plan” on page 41.

To change power plan settings
1. Open Motion Dashboard to the Power panel (page 26).
2. Tap the Power Options button.
3. On the Power Options page, tap Change plan settings for the plan you want to change.
4. Choose the settings that you want your computer to use. You can also tap Change advanced power settings for more options.

Creating a power plan
If the existing power plans are not sufficient, you can create your own power plan.

To create a power plan
1. Open Motion Dashboard to the Power panel (page 26).
2. Tap the Power Options button.
3. On the Power Options page, tap Create a power plan.
4. Select the existing plan that is closest to the plan you want to create.
5. In the Plan name box, enter a name for the plan, and then click Next.
6. Choose the settings that you want your computer to use, then click Create.

Using Sleep
Sleep is a state in which your tablet PC’s internal devices are turned off to save power. When you want to use the computer again, it comes out of Sleep quickly, although you may have to log on again.

Use Sleep to save power when you will be away from the computer for a short time.

WARNING: Because Sleep does not save your desktop state to disk, a power failure while on Sleep can cause you to lose unsaved information.

To put your computer on Sleep
1. Open Motion Dashboard to the Power panel (page 26).
2. Do one or more of the following:
   • For Power Switch on battery, select Sleep.
   • For Power Switch plugged in, select Sleep.
3. To put your computer on Sleep, press the power button.

To turn your computer back on, press the power button.
Using Hibernate

Hibernation is a state in which your computer shuts down to save power but first saves everything in memory on your hard disk. When you restart the computer, your desktop is restored exactly as you left it. Use hibernation to save power when you will be away from the computer for an extended time.

Hibernation has the following advantages over Sleep:

• You should save and close any remote files or applications before hibernating.
• Hibernate saves the state of the desktop and tablet applications
• Hibernate consumes no battery power
• When you return from the Hibernate state, you return to where you were when you entered hibernation.

To put your computer on Hibernate

1. Ensure that Hibernate is enabled.
2. Open Motion Dashboard to the Power panel (page 26).
3. Do one or more of the following:
   • For Power Switch on battery, select Hibernate.
   • For Power Switch plugged in, select Hibernate.
4. To put your computer on Hibernate, press the power button.

To turn your computer back on, press the power button.
Using the battery
The Tablet PC runs on battery power when it is not plugged in. The battery, included with the Tablet PC, is installed on the back of the tablet. To increase your battery life, you can install a second battery in any of the two battery bays. If a second battery is not installed, a battery bay cartridge (non-functioning) is provided to occupy the second battery bay. For more information, go to the Motion Computing accessories page at www.motioncomputing.com/accessories.

Checking battery power
You can check the remaining battery power from Motion Dashboard, from the battery icon in the notification area, or from the battery itself.

To check the remaining battery power
• Open Motion Dashboard to the Power panel (page 26).

You can also place the pointer over the battery icon in the notification area. The battery icon provides a graphical representation of the remaining battery power. It shows both cumulative and individual power readings for the batteries installed.
You can also check the remaining battery power from the battery itself.

**To check the battery status using the gauge on the battery**

- Locate the battery gauge button and the battery power indicator lights and press the battery gauge button. The indicator lights show the remaining charge. Each light represents approximately 20% of the available charge.
- A Battery fault code is indicated when you push the battery gauge button and the top, middle, and bottom lights on the battery illuminate simultaneously. If this occurs, the battery has failed and must be replaced.
Charging the battery

When the Tablet PC is connected to AC power, the battery automatically charges until it reaches full charge, even if the Tablet PC is being used. The battery status light on the Tablet PC will blink amber when the battery is installed and AC power is applied to the tablet.

If two batteries are installed, the battery that the tablet is using charges first, then the second battery charges. The charging sequence is staggered to ensure that both batteries are being fully charged at nearly the same time. The first battery (with lowest remaining power) charges to the 90% level, followed by the second battery charging to the 100% level. Then, the tablet switches to the first running battery.

For information about the battery status light, see “Battery status light” on page 12.

CAUTION: To avoid injury, keep the battery within the recommended temperature range while it is charging. If the battery has been subjected to a hot environment, wait until it cools to room temperature before recharging it. For more information, see the Safety and Regulatory Guide included with the Tablet PC.

Battery and power management tips

• To lengthen the battery’s usable life, use AC power when you can. The battery will charge automatically while you run on AC power, so leave the battery in the tablet while you are working.
• For optimal battery life, use AC power when using a CD or DVD player.
• When running on battery power, place the system in Hibernate or Sleep mode if you are going to leave it unattended for more than a few minutes (page 42).
• Remember that the display, processor, PC Cards, wireless cards, and accessory drives all draw on the battery, so adjust properties and disable unused accessories while running on battery power.
• When running on battery power, adjust the display brightness to a dimmer setting and enable Dynamic brightness. See “Adjusting the display brightness” on page 35.
• Turn off wireless devices when they are not being used.
Removing and replacing the battery
You can remove the battery to check the remaining power, or to replace it with a fully charged battery.

To remove the battery
1. Ensure that the Tablet PC is plugged in to AC power or turned off.
2. Turn the Tablet PC over so that the back side is up.
3. For the battery you want to remove, slide the battery release switch until the battery is partially ejected, and then pull the battery out of the battery bay.

To replace the battery
• For the battery you want to install, place the two tabs of the battery into the two slots in the battery bay, and then press the other end of the battery into the battery bay until you hear a click or feel the battery lock into place.
Hot Swapping the battery
You can hot-swap a battery while the tablet is on and running on battery power only if you have a second battery to replace the battery that is low on power.

To swap a battery with a tablet containing a battery and battery bay cartridge (non-functioning)
• If your tablet has a battery and battery bay cartridge (non-functioning) installed, remove the battery bay cartridge and install the second battery. For information about removing the battery, see “Removing and replacing the battery” on page 46.

To hot-swap a battery with a tablet containing two batteries
• If your tablet has two batteries installed, remove the battery with the lowest power and install the charged battery in the other battery bay. For information about removing the battery, see “Removing and replacing the battery” on page 46.

To determine which battery needs to be replaced, see “Checking battery power” on page 43.

Important: Use only Motion Computing J-Series batteries with the J-Series Tablet PC.

Battery maintenance
To maximize the performance of the tablet batteries, deplete each battery’s charge level to less than 10% every 30 days. To deplete the charge, install the battery on the tablet and use the tablet without AC power until the battery charge is depleted to less than 10%. Verify the status of your battery using the battery icon in the notification area of your tablet desktop. See “Checking battery power” on page 43.

Long-term battery storage (not attached to tablet)
Do not store any batteries with a full charge; this can cause a permanent loss of charging capacity. For long-term storage, the battery should be charged to a level between 20% and 40% (two contiguous LEDs illuminated) of a full charge. Stored batteries should be checked every 90 days to determine the charge status. If only one LED or no LED is illuminated, recharge the batteries to a level between 20% and 40%.

For optimum care, store the battery in a cool, dry environment. Never expose the battery to temperatures above 60ºC (140ºF).

Note: In storage, the batteries will self-discharge at a rate of 10% of the total capacity per month.

Disposing of used batteries
When Lithium-ion (Li-ion) batteries are no longer serviceable, the batteries should be sent to a hazardous materials recycling center. Do not discard the batteries in a waste receptacle because they could be sent to a landfill.
Removing and replacing the SIM
To remove and replace the SIM, perform the following procedures.

**To remove the SIM**

1. Turn off the tablet.

2. Remove the battery or battery bay cartridge (non-functioning) from the right battery bay.

   Slide the battery release switch until the battery is partially ejected, and then pull the battery out of the battery bay.
3. Lift the corner of the plastic film covering the SIM slot and slide the SIM out of the slot.

4. If you are not replacing the SIM, replace the battery or battery bay cartridge by placing the two tabs of the battery or battery bay cartridge into the two slots in the battery bay, and then press the other end of the battery into the battery bay until you hear a click or feel the battery lock into place.

   If you are replacing the SIM, perform the following procedure.
To replace the SIM

1. With the tablet turned off and the battery or battery bay cartridge removed from the right battery bay, lift the plastic film covering the SIM slot and slide the SIM into the slot with the metal contacts facing downward and the notched corner positioned as shown in the illustration.

2. Replace the battery or battery bay cartridge in the right battery bay by placing the two tabs of the battery or battery bay cartridge into the two slots in the battery bay, and then press the other end of the battery into the battery bay until you hear a click or feel the battery lock into place.
Using Motion OmniPass and the fingerprint reader

Motion OmniPass offers a secure and convenient system for managing your passwords and providing confidentiality for your sensitive data through file encryption.

**To start Motion OmniPass**

Do one of the following:

- Click **Start > All Programs > Motion OmniPass > OmniPass Control Center**.
- In the notification area, double-tap the Motion OmniPass icon ( ).

You can also start Motion OmniPass from the Security panel of Motion Dashboard.

To create a new user and capture a fingerprint in OmniPass, see “Capturing a fingerprint” on page 51.

From the OmniPass Control Center, you can manage OmniPass users and settings (distinct from Windows users), change OmniPass settings, manage passwords, and protect your files. For more information, see the OmniPass Help.

**Capturing a fingerprint**

After you capture your fingerprints, you can associate the fingerprints with an OmniPass user. This offers a quick and convenient way to log on to your Tablet PC, provides global password management, and helps protect your data from unauthorized access.

Use this procedure to enroll a new user and capture a fingerprint for authentication.

**To enroll a new user and capture a fingerprint**

1. Start Motion OmniPass (page 51) and tap **Enroll a new user**.
2. Enter the Windows account information for the new user and tap **Next**. The fields may default to the user name of the current user.
3. In the Choose Finger window, tap on the finger you want to enroll, then tap **Next** or **Practice**. Practice allows you to do a trial run of the fingerprint capture.

4. Place the selected finger over the fingerprint reader and slowly drag your finger across the sensor in a downward motion or in an upward motion.

   If the capture is successful, a green fingerprint image will appear in the capture area. If the capture is unsuccessful, follow the instructions on the screen to improve the scan.

   After you have successfully captured your fingerprint, scan your fingerprint one more time for verification.

5. Tap **Next**, then tap **Yes** if you want to enroll a second fingerprint (recommended). If you injure a finger, you can use a second finger to authenticate.
You can also capture a second fingerprint later. From the OmniPass Control Center, tap Run User Management Wizard, then tap Modify a user’s device enrollment.

6. Select your user preferences and tap Next. On the Backup User Profile screen, tap Backup Now.

7. Select a location for your backup profile and tap Save. Enter a password and tap OK. On the final screen, tap Done.

You should keep your backup profile in a secure location, such as on an external drive that you can remove and store in a secure environment.

If your profile is lost or corrupted, you can restore it later. You should back up your profile periodically to protect your configuration and any stored passwords and encryption keys. For more information, see the OmniPass Help.

Fingerprint reader tips

- Be consistent. Hold your finger and scan at the same angle each time. For example, if you enroll your finger with your hand open, hold your hand this way each time you scan.
- The scanner is bi-directional. You can move your finger in an upward or downward motion across the sensor.
- Read the prompts carefully and ensure that you wait for the prompt before you swipe.
- Swiping too fast or too slow can make a capture unsuccessful. Change the swipe speed until you learn what speed works best.
- When scanning, press hard enough to fully contact the entire surface of the fingerprint reader; you do not have to press hard.
- Rub your fingers together to stimulate the natural skin oils so your fingerprint is easier to detect. Conversely, wipe your finger off so nothing interferes with the scan.
- If you are having trouble enrolling a specific finger, enroll a different finger. Typically, you should scan an index finger, thumb, middle finger, ring finger, and little finger in that order.
- If you are repeatedly having trouble getting a good scan, you may need to clean the sensor. See “Cleaning the fingerprint reader” on page 66.

Using password replacement

OmniPass can manage your passwords for other applications, such as Web sites, Internet email, FTP, or any restricted-access network resource. After OmniPass registers your credentials, you can access any of these restricted areas by using your fingerprint or the master password.

To register passwords

1. When you encounter a user name and password prompt, enter your user name and password, but do not log on. (Do not tap Enter, Submit, or OK.)

2. Right-click the OmniPass icon, and select Remember Password. The Windows arrow pointer changes to the OmniPass golden key.

3. Click the key cursor on the window that has the password that you want OmniPass to remember.
Note: For some applications, you may have to use the password wizard to register passwords. See “Using the password wizard” on page 54.

4. Enter the following information:
   • **Friendly Name.** A descriptive name to identify the password box.
   • **Automatically enter.** Instantly accesses the site without requiring a password or fingerprint scan. If you are logged in to OmniPass and you access a secure Web site, OmniPass will automatically submit your user name and password without prompting for verification.
   • **Automatically click.** Prompts you for your OmniPass/Windows password or fingerprint scan when you access the site (default).

5. Tap **Finish**.

6. If prompted, swipe your fingerprint or enter your master password to authenticate these settings.

**Using the password wizard**

Certain applications require more sophisticated user input for authentication. For these applications, you may need to use the password wizard to set up password replacement.

**To run the password wizard**
1. Start Motion OmniPass (page 51).
2. In the left pane, tap **Password Wizard**.
3. Follow the instructions in the wizard program.

**Logging on to a remembered site**

To log on to a remembered site, open the Web site or application that you have set up with password replacement. See “Using password replacement” on page 53. Swipe your finger or enter the master password when prompted.

To remove a remembered site, tap **Manage Passwords**.

**Configuring authentication rules**

**To configure authentication rules**
1. Start Motion OmniPass (page 51).
2. Tap **Change Your User Settings**.
3. Tap **Set user authentication rules and policies**.
4. Select the appropriate authentication rules.
5. Tap **Save all settings**.
Using Windows Security Center

Windows Security Center provides a central location for you to manage your computer’s security settings and learn more about improving security. If a problem is detected (such as an out-of-date antivirus application), the Security Center sends you an alert and provides recommendations for how to remedy the situation.

Windows Security Center manages the following:

- **Windows Firewall.** Protects your computer against viruses and other security threats, such as intruders who might try access over the Internet or a network.
- **Windows Updates.** Keeps your computer up to date by notifying you of important Windows updates. You can configure Automatic Updates to download and install updates automatically.
- **Malware protection.** Protects you from viruses, spyware, and other unwanted software.
- **Other security settings.** Manages Internet security settings and User Account Control to help protect your computer. Internet security settings apply to Internet Explorer, but not to other Web browsers.

To learn more about Windows Security Center, open Motion Dashboard to the Security panel, then tap **Windows Security Center**.
Setting up users and passwords
You can use different types of user accounts and passwords to create various levels of protection for your Tablet PC and its data, depending on the level of security that you need.

Setting up Windows user accounts
You can use Windows user accounts to help secure the files on your computer from other users. You must have an administrator account on the computer to add a new user to the computer.

To set up a Windows user account
1. In Control Panel, tap the User Accounts and Family Safety category.
2. Tap Add or remove user accounts.
3. Tap Create a new account.
4. Enter the appropriate information for the new user account and tap Create Account.

Setting a BIOS password
You can use a BIOS password to secure the basic input/output system of the computer.

WARNING: Read this section carefully to understand the implications of creating a BIOS system password. If you forget the password, you will not be able to access your Tablet PC. If this happens, contact Motion Computing Technical Support at www.motioncomputing.com/support. Have your serial number ready. You can find the serial number in one of the battery bays of the Tablet PC.

To set a BIOS password
1. Start the Tablet PC.
2. When the Motion Computing splash screen appears, press the Dashboard button ( ).
   When access is enabled, you will hear an alert sound. If you miss the splash screen, restart the computer and try again.
3. Quickly tap the screen with the tablet pen to open the system setup menu. If you have a keyboard attached, you can also press the space bar to open the system setup menu.
4. Tap Password Options.
5. In the Password window, select Change current password and enter a password using the on-screen keyboard.
6. Select Enable Password on boot, if desired.
   A BIOS password requires the user to enter a password to open the BIOS. A password on boot requires the user to enter a password to start the computer.
7. Tap OK.

To clear the password, select Change current password, leave the password fields blank, then tap OK.
Setting up a hard disk drive (HDD) password
You can use a HDD password to protect the computer and the hard disk drive. The computer cannot be started without the HDD password, and the data on the disk drive cannot be accessed, even if it is removed and attached to a different computer.

To set up a hard disk drive password
1. Start the Tablet PC.

2. When the Motion Computing splash screen appears, press the Dashboard button ( ).
   When access is enabled, you will hear an alert sound. If you miss the splash screen, restart the computer and try again.


4. Tap Enter for Set Hard Disk Password.

5. To enter a password, tap the password dialog box and an on-screen keyboard will open.

6. Using the on-screen keyboard, enter the password and tap Enter. To confirm the password, enter the password again, and tap Enter.

7. Tap Enter to continue, tap Exit, then select Exit Saving Changes.

To clear the password, tap Enter for Set Hard Disk Password. Enter the current password, then tap Enter twice to leave the Enter New Password fields blank.
Using Wi-Fi (802.11a/g/n)

Use the information in this section to set up a Wi-Fi connection. Wireless access requires an 802.11a, 802.11g, or 802.11n access point. Internet access requires a working Internet connection.

**DANGER:** FAA regulations require that you disable any wireless connection when traveling by air. Failure to disable the wireless connection on the Tablet PC while traveling by air can cause communications problems with aircraft instruments.

Enabling or disabling Wi-Fi

Before you can establish a Wi-Fi connection, you must enable the Wi-Fi adapter. You can enable the Wi-Fi adapter using Motion Dashboard.

**To enable or disable Wi-Fi**

1. Open the Motion Dashboard to the Wireless panel (page 26).
2. Select or clear the **Enable 802.11 Internal Wireless** check box.

Setting up a Wi-Fi connection

Use this procedure to create a Wi-Fi connection.

**To set up a Wi-Fi connection**

1. Open the Motion Dashboard to the Wireless panel (page 26).
2. Ensure that **Enable Internal 802.11 Wireless** is selected.
3. Tap the **Properties** button.
4. In the Network Connections center, tap the wireless network connection.
5. Tap **Connect To**, then select a network.

   **Note:** If you are connecting to a secure network, you may need to enter authentication information.

For more information about Wi-Fi, see “Wi-Fi (802.11a/g/n wireless)” on page 20.
Using Mobile Broadband (optional)
Use the information in this section to set up a Mobile Broadband connection. Mobile Broadband access requires a service contract from a Mobile Broadband service provider.

For more information, see “Mobile Broadband (optional)” on page 21.

WARNING: FAA regulations require that you disable any wireless connection when traveling by air. Failure to disable the wireless connection on the Tablet PC while traveling by air can cause communications problems with aircraft instruments.

Activating your Mobile Broadband service
Before you can use the Mobile Broadband service, you must activate your service with the service provider you chose when you ordered your Tablet PC.

You may be able to activate your service using the connection manager, or you may have to call your service provider to activate. For more information about starting the connection manager, see the Mobile Broadband document in the Tablet PC box.

Enabling Mobile Broadband
Before you can establish a Mobile Broadband connection, you must enable the Mobile Broadband adapter. You can enable the Mobile Broadband adapter using Motion Dashboard.

To enable Mobile Broadband
1. Open the Motion Dashboard to the Wireless panel (page 26).
2. Select the Enable Mobile Broadband with GPS check box.

Installing the connection manager

To install the connection manager
• Double-tap the icon on your desktop and follow the online instructions. You will need an Internet connection to download your connection manager.

For more information, see the connection manager help.

Note: The connection manager software you use depends on your wireless service provider. If your tablet contains a Mobile Broadband card, for more information, see the Mobile Broadband document in the Tablet PC box.

Connecting and disconnecting
Use the connection manager software to connect to and disconnect from your provider’s Mobile Broadband network.
Using Bluetooth (optional)
You can use Bluetooth® to connect to accessory devices or other computers. The devices can communicate with each other when they are in range. For more information, see “Bluetooth wireless (optional)” on page 21.

Enabling or disabling Bluetooth
Before you can set up a Bluetooth device, you must enable the Bluetooth adapter on the Tablet PC. After you enable Bluetooth, the Bluetooth icon ( ) appears in the notification area. You can tap on this icon to get shortcuts to the Bluetooth Settings window, the Bluetooth File Transfer Wizard, and the Add New Connection Wizard.

To enable or disable Bluetooth
1. Open Motion Dashboard to the Wireless panel (page 26).
2. Select or clear Enable Internal Bluetooth Wireless.

After you enable Bluetooth, the Bluetooth adapter tries to discover other Bluetooth devices within range. When a Bluetooth device is discoverable, it is visible to other Bluetooth devices in range. For information about making a device discoverable, see the device’s documentation.

Setting up a Bluetooth device
Before you can use a Bluetooth device with your Tablet PC, you need to set up the device. After you set up the device, it is paired with your Tablet PC, and uses a passkey to create a secure connection between the Tablet PC and the Bluetooth device.

Note: Although the passkey exchange helps to secure your data, Bluetooth wireless technology should not be considered completely secure.

To set up a Bluetooth connection
1. Ensure that Bluetooth is enabled.
2. Place the Bluetooth device in discoverable mode. Each Bluetooth device may have a different way to make it discoverable. See the manufacturer’s documentation for more information.
3. In the Control Panel, tap Hardware and Sound > Devices and Printers, then tap Add a device.

The Select a device to add to this computer window displays and Windows searches for your Bluetooth device.

Note: If the device is not discovered, see “If the device is not discovered…” on page 61.
4. Select your Bluetooth device after Windows displays the device, then click Next.
5. Select a pairing option, then click Next.

Once the device is added, Windows displays a window confirming the Bluetooth device has been added.
6. Tap **Devices and Printers** to verify the device has been added or click **Close** to close the window.

**If the device is not discovered...**

If the Bluetooth device is not detected after multiple attempts, try the following:

- Ensure that Bluetooth is enabled (page 60).
- Ensure that the device you are adding is discoverable. See the manufacturer's documentation for more information.
- Ensure that the Bluetooth device has good batteries.
- For Tablet PCs transferring files, both tablets must turn on the device transfer wizard, although only the receiving Tablet PC needs to be discoverable. Tap the Bluetooth icon and then **Send a file** or **Receive a file**. When you do this, discovery is automatically turned on for the receiving device.
- Check which Bluetooth devices are connected. Tap the Bluetooth Devices icon and select **Show Bluetooth Devices**. On the Devices window, you can see Bluetooth devices that are currently connected.

If the Tablet PC still cannot detect the Bluetooth device, contact the device manufacturer for assistance.

**Bluetooth wireless tips**

Motion Computing and its Bluetooth partners have worked to ensure a positive experience with this technology, and to ensure Bluetooth interoperability. In doing so, we have found the following issues:

- If you are running Bluetooth and Wi-Fi at the same time, interference can affect the Bluetooth performance. This is most noticeable when you try to transfer large amounts of data, such as file transfers or printing large documents. This may also be noticeable when you try to transfer large or small amounts of data may if several Bluetooth devices are operating simultaneously in an office.
- Bluetooth audio has not been fully developed for speech recognition. Therefore, for speech recognition, we recommend that you not use a Bluetooth wireless headset. Moreover, Motion Speak Anywhere can record clear audio, dictate notes, and use voice commands without a microphone headset.
- Some Bluetooth devices will disconnect when they go into power-saving mode. Most devices will automatically reconnect when they become active again.
- If you attempt to install other wireless headset or other audio drivers (such as Bluetooth or USB) over the Tablet PC audio drivers, a malfunction of the Tablet PC audio system may occur because the drivers may not be compatible.
- Occasionally, some Bluetooth device compatibility issues can occur. If you are having problems with interoperability of Bluetooth devices, contact the manufacturer of your Bluetooth device and check its compatibility with the Bluetooth software installed on your Tablet PC.
Finding additional software
For information about other tablet-oriented software, go to the Motion Computing software page at www.motioncomputing.com/products/software_motion_J34.asp.

You will find links to software solutions for purchase as well as free downloads from Motion software and service partners.
Care and Maintenance

Proper care and maintenance will keep your Tablet PC working and in good condition for a long time. For general information about care of the Tablet PC and its components and accessories, see the Safety and Regulatory Guide included with your Tablet PC.

This chapter describes the care and maintenance procedures for your Tablet PC.

WARNING: Follow the guidelines listed below when caring for your Tablet PC and its components. Improper use may damage the Tablet PC and its components and void the warranty.

General care

• Protect the Tablet PC from exposure to extreme temperatures, shock, liquids, and strong magnetic fields.

• If you are storing the Tablet PC for a long time, unplug the power adapter and remove the battery after partially discharging it.

• Do not place heavy objects on top of the Tablet PC.

• Do not open the Tablet PC case or you will void the warranty.
Standard display

• Clean fingerprints and most marks from the display surface by wiping it with the soft cloth (provided). Never spray or pour liquids directly onto the display surface itself. Never use an abrasive cleaner on the display. If liquid is spilled on the display, wipe it up immediately.

• If needed, spray a soft cloth (not directly on the display) with a window-type cleaner and wipe the display.

• Avoid using tissues or paper towels to clean the display surface. These contain wood fibers that can scratch the display.

• Use only the tablet pen on the display. Do not write on the display with an ink pen or pencil, or any other object that could damage the display.

• Protect the display surface from unnecessary contact by using a case when transporting the Tablet PC.

• Avoid exposing the display to direct sunlight for long periods of time.

View Anywhere display (optional)

• Clean fingerprints and most marks from the display surface by wiping it with the soft cloth (provided). Never spray or pour liquids directly onto the display surface itself. Never use an abrasive cleaner on the display. If liquid is spilled on the display, wipe it up immediately.

• If needed, clean with any alcohol-based product recommended for anti-reflective glass. Other cleaning products might leave a residue.

• Avoid using tissues or paper towels to clean the display surface. These contain wood fibers that can scratch the display.

• Use only the tablet pen on the display. Do not write on the display with an ink pen or pencil, or any other object that could damage the display.

• Protect the display surface from unnecessary contact by using a case when transporting the Tablet PC.

• Avoid exposing the display to direct sunlight for long periods of time.
Cleaning in a health care environment
This section describes the cleaning procedures for a Tablet PC in a health care environment.

Disinfecting procedures
You should periodically disinfect the tablet according to the institutional policies of surface and equipment safety and cleanliness.

According to the Centers for Disease Control, “items that do not ordinarily touch the patient or touch only intact skin are not involved in disease transmission, and generally do not necessitate disinfection between uses on different patients.”¹ We recommend using an EPA-approved low-level disinfectant when general cleaning is required. For a list of cleaning solutions tested by Motion Computing, see “Cleaning solutions” on page 65.

If the tablet becomes soiled with blood or other body fluids, chemical germicides that are EPA-approved for use as hospital disinfectants and that are tuberculocidal/virucidal when used at recommended dilutions and contact times can be used. Visibly soiled areas should first be cleaned and then chemically decontaminated. For disinfection, the cleaned areas should be moistened with the appropriate germicide and allowed to air dry.²

If a tablet is used with patients who are infected or colonized with vancomycin-resistant enterococci or other drug-resistant microorganisms judged by the infection control program (based on current state, regional, or national recommendations, to be of special or clinical or epidemiologic significance or with highly virulent microorganisms such as Ebola or Lassa), then the tablet should be dedicated to one patient or patient cohort or subjected to low-level disinfection between patient uses.¹

Training and documentation considerations
All users of Motion Tablet PCs in the health care environment should be provided with training on proper cleaning procedures. Cleaning procedures should be added to the institution’s policies and procedures for infection control.

Cleaning solutions
Motion Computing maintains a list of tested cleaning solutions and chemical disinfectants on the Motion Computing web site at http://www.motioncomputing.com/choose/spec_clean_j3400.htm.

WARNING: Do not use any solution that is corrosive or abrasive to clean or disinfect the J3400 Tablet PC.

If you are concerned whether a cleaner or disinfectant will harm your tablet PC, contact Motion Computing support.

Cleaning the fingerprint reader
Under normal circumstances, you should clean the fingerprint reader once a month, or whenever necessary.

To clean the fingerprint reader
1. Shut down the Tablet PC, unplug it, and remove the battery.
2. Lightly spray a cotton swab with household window cleaner.
3. Gently rub the sensor surface with the cotton swab, slowly rotating the swab so a new, clean surface of the swab is constantly exposed to the sensor surface. Do not allow cleaner to drip or run down into the electronics around the sensor.

   Do not use bleach, solvents, or abrasives. Do not spray or pour any liquid directly on the sensor.

4. After cleaning, gently rub the surfaces again with a clean, dry cotton swab. Use a clean swab each time you clean the sensor.
Pen

- Store the pen in the pen bay or in a case when not in use.
- Do not store the pen vertically on the tip. Constant pressure on the tip can affect the pen-to-digitizer interaction.
- Change the pen tip regularly. See “Replacing pen tips” on page 67.
- Do not immerse the pen in liquid. It contains electronic components that could be damaged.
- In certain environments, particles or debris can stick to the pen tip or the Tablet PC display. To avoid damaging the display, clean it frequently with the provided cleaning cloth. Also, change pen tips regularly, especially if you drop the pen onto a rough surface that could damage the tip or embed debris in it. Damaged pen tips can scratch the display.

Replacing pen tips
Pen tips eventually wear down or get damaged, so the pen includes extra tips and a tool for replacing them.

With typical use, you should change the pen tip every 90 days. If you use the pen in a dirty environment, you should change the pen tip every 30 days. Particles can become embedded in the pen tip and scratch the display.

To replace the pen tip
1. Grasp the old tip with the tip replacement tool. Use the notch on the ring to grab the tip.
2. Pull the old tip out of the pen.
3. Insert a new tip, placing the flat end of the pen tip in first.
4. Apply slight pressure to push the pen tip into place.

Ordering new pens
To order additional pens, go to the Motion Computing accessories page at https://store.motioncomputing.com/.
Traveling with your Tablet PC
Use the following tips when you travel with your Tablet PC:

- Remove all accessories and cables. Remember to pack those you will need while traveling, including at least one tablet pen.
- Put the Tablet PC into a portfolio or other case to protect the display.
- Protect the pen by keeping it in the pen bay or in a case during travel.
- Pack the Tablet PC securely in a briefcase or hand-carried luggage, and keep it separate from toiletries, liquids, and food. Do not pack it in checked luggage.
- Keep the Tablet PC stable during travel. Secure it to prevent it from sliding around in overhead bins and car trunks.
- Before extended use in the field or long trips away from AC power, adjust the power properties to maximize battery conservation. You can adjust the power properties from Motion Dashboard. See “Using power plans” on page 40.
- For international travel, obtain and use the appropriate adapters for your destination’s electrical outlets. A current converter is not necessary.
- You may want to carry proof of ownership or a merchandise passport when traveling internationally.
- Consult your insurance company and credit card company to learn about emergency travel assistance in case your Tablet PC becomes lost or disabled.

Traveling by air
Use the following tips when traveling by air.

- Have a fully charged battery in case security personnel ask you to start the Tablet PC.
- Have it hand-inspected or sent through the X-ray scanner, but never carry it through the metal detector.
- Turn off the Tablet PC off or place it in hibernation mode for takeoff and landing.

FAA Wireless air travel requirement
The FAA requires that you suspend wireless operations, such as Wi-Fi and Bluetooth, before boarding a plane. You can disable all wireless by opening the Dashboard to the Wireless tab, and under 802.11 Wi-Fi, uncheck the Enable 802.11 Internal Wireless.

To disable external wireless, remove any wireless PC cards. Failure to suspend wireless operations while traveling by air can cause problems with aircraft instruments.

**DANGER:** Do not transport Li-ion batteries in checked baggage. The baggage hold can get very hot, which can overheat the Li-ion battery and result in an explosion. You can take up to two spare batteries in carry-on luggage, in addition to the one in your Tablet PC. Transporting batteries in checked baggage or transporting more than two spare batteries is a violation of federal transportation regulations.
Creating a backup archive

If you want to roll back your tablet to a predetermined state, you can create a backup archive.

**To create a complete PC backup archive**
1. From the Control Panel, tap the **System and Security** category, then tap **Backup and Restore**.
2. Tap **Create a system image** in the left navigation bar, then follow the instructions.

*Note:* You will need an external USB hard disk drive or DVD drive attached to store the backup copy.

**To back up individual files**
1. From the Control Panel, tap **System and Security** category, then tap **Backup and Restore**.
2. Tap **Set up back up**.
3. Follow the instructions to back up selected files to protect against loss or accidental deletion.

Restoring data

If you experience a problem, you can use the Windows Recovery Environment to repair your Windows 7 files, or you can restore your computer to the state it was in when it left the factory. If a serious problem occurs and Windows 7 will not restart, the Windows Recovery Environment Repair will automatically start. Additionally, you can create your own backup data archives and restore those later. For more information, see “Creating a backup archive” on page 69.

Using Windows Recovery Environment

When using the Windows Recovery Environment, you will need a keyboard connected to the tablet.

**To repair Windows 7 files**
1. After your tablet restarts after the initial BIOS display screen, press and hold the **F8** key.
2. On the **Advanced Boot Options** screen, select **Repair your computer** and press the **Enter** key.
3. Select a keyboard layout and click **Next**.
4. Select a user name and enter the password, and then click **OK**.
5. On the **System Recovery Options** menu, click **Startup Repair**.
**To restore from your complete PC backup archive**
1. After your tablet restarts after the initial BIOS display screen, press and hold the F8 key.
2. On the Advanced Boot Options screen, select Repair your computer and press the Enter key.
3. Select a keyboard layout and click Next.
4. Select a user name and enter the password, and then click OK.
5. Attach the USB hard disk drive or DVD drive that you used to store your complete PC backup archive.
7. Follow the instructions in the Re-image your computer dialog.

**To restore the original factory image**
1. After your tablet restarts after the initial BIOS display screen, press and hold the F8 key.
2. On the Advanced Boot Options screen, select Repair your computer and press the Enter key.
3. Select a keyboard layout and click Next.
4. Select a user name and enter the password, and then click OK.
6. Click Yes to reinstall Windows.

   *Your current data will be saved in a Windows.old directory.*

   *After the image has been restored, the Set Up Windows dialog displays.*

**Using Windows 7 to restore individual files**
You can restore data that you archived.

**To restore backup files**
1. In the Control Panel, tap the System and Security category, then tap Backup and Restore.
2. Tap Restore Files.
3. Follow the instructions to restore individual files and folders that have been accidentally deleted or damaged.
Troubleshooting and Support

Motion Computing Tablet PCs are thoroughly tested for performance and quality, but occasionally problems still occur. If you do not find the information you are looking for in this section, go to the Motion Computing support page at www.motioncomputing.com/support.

Troubleshooting
Use the information in this section to identify and resolve common issues. If an issue has more than one potential cause, the most common cause is listed first.

Power

The computer does not turn on
• The power button might not be fully pressed. Press and hold the power button for at least a half-second, but no more than three seconds.
• The tablet might not be plugged in or battery might be depleted. Plug the tablet in to AC power.

The computer does not shut down
• An application might have stopped responding. Use Task Manager to manually stop the application. (Press the Windows Security button and tap Start Task Manager.) For more information, open Windows Help and Support and search for “task manager”. You can also press and hold the power button for five seconds to force the tablet to shut down.

The computer will not enter Hibernation mode.
• Hibernation might not be enabled. Use Motion Dashboard to enable Hibernation. See “Using Hibernate” on page 42.

The computer does not return from Hibernation while on battery power
• The battery might be depleted. Plug the computer in to AC power.
The display goes black while the Tablet PC is still turned on

• The computer might have turned off the display to save power. To restore the display, touch the screen with the tablet pen or press a button.

• The computer might have gone into Sleep mode. In Sleep mode, the power status light flashes blue. Press and hold the power button for about one second.

• The computer might have gone into low-battery Hibernation mode. In low-battery Hibernation mode, the power status light is off. Plug the computer in to AC power, then press and hold the power button for about one second.

Battery

The battery does not last very long (less than three hours)

• Hot or cold conditions can adversely affect the battery charge. Use AC power if you are operating the computer in these conditions.

• Accessory devices such as a DVD player and applications that make heavy use of the hard drive can drain the battery more quickly. Remove the accessory devices or use AC power if possible.

• The battery may be weakening. Use a different battery if possible. To order a new battery, go to www.motioncomputing.com/accessories.

I lost data while swapping batteries

• You can swap batteries only if:
  – The tablet is running on AC power while you swap the battery.
  – You have a second battery to place in the second battery bay before removing the battery in the first battery bay.

For information about swapping batteries, see “Hot Swapping the battery” on page 47.

Display

The desktop area is larger than the Tablet PC display

• If the display resolution is set higher than the display can support, the desktop area scrolls as you move around. Decrease the display resolution so that the entire desktop is visible. For more information, open Windows Help and Support and search for “change resolution”.

When I disconnect an external monitor, the desktop area is larger than the Tablet PC display

• The computer may have expanded the desktop beyond the display area of the Tablet PC display. Use Motion Dashboard to set the Tablet PC as the active display. For more information, see “Setting up an external display” on page 36.

1. Open Motion Dashboard to the Display panel (page 26).

2. Tap the Display Settings button.

3. Select Notebook to make the Tablet PC the primary display.
The display is too dim

- The brightness may be set too low. Use Motion Dashboard to increase the brightness. See “Adjusting the display brightness” on page 35.

The display is unreadable or distorted

- The screen resolution and color quality may be set incorrectly. Use Windows Display Properties to reset the display settings.
  1. In Control Panel, tap the Hardware and Sound category, then tap Display.
  2. Choose Smaller or Medium to change the text size.
- The display driver may have been removed or become corrupted. Use Windows Device Manager to reinstall the driver.
  1. In Control Panel, tap the System and Security category, then tap System.
  2. Tap Device Manager in the left navigation field.
  3. Expand Display adapters.
  4. Select the adapter and select Action > Update Driver Software.
  5. Follow the instructions in the setup program.

Input

The Tablet PC does not respond to the pen I am using

- You may be using an improper input device. Only Motion tablet pens can be used to write on the Tablet PC display. The Tablet PC does not respond to other pens or to a plastic stylus.
- You may be using the wrong tablet pen. Occasionally, a particular tablet pen may not work with a particular Tablet PC. If you are in an environment with multiple tablets and pens, try using a different pen. You can also tether the pen to the tablet to ensure that a pen stays with its tablet.

The pointer on the screen does not align with the tablet pen

- The pen may need to be calibrated. See “Calibrate the digitizer” on page 7.

When I write, I inadvertently click the function button on the pen

- Try adjusting how you hold the pen. Avoid resting your finger on the function button. You can also disable the button. See “Configuring pen options” on page 29.

The pen function button does not work

- The pen function button may not be enabled.
  - You can use the Pen and Input Devices window to enable the button. Open Help and Support and search for “Pen and Input Devices”.
  - You may not be pressing the button early enough. Try pressing the pen function button before you touch the pen to the display surface.
The eraser does not work
- The eraser may not be enabled.
  - You can use the Pen and Input Devices window to enable the eraser. Open Help and Support and search for “Pen and Input Devices”. The eraser works on ink only, not text.

The buttons on the Tablet PC do not do what I expect them to do
- The button functions may have been customized. You can use the Tablet and Pen Settings window to change the buttons to the desired functions. See “Configuring front panel buttons” on page 30.

Ports and connectors

The system does not recognize the Express card I inserted
- The card might be inserted improperly. Eject the card and re-insert it. Ensure the label side is up. See “Express card slot (optional)” on page 20.
- The device may not have been tested for Windows compatibility. For a list of tested products, go to the Windows Marketplace Tested Products page at winqual.microsoft.com/hcl.

The system does not recognize a USB device
- Windows may take a short time to recognize a USB device. Wait a few moments to see if Windows recognizes the device.
- The device may not be connected properly. Check the connection and ensure it is inserted properly into a USB port. You can also try a different port.
- The correct driver might not be included with Windows. Check the manufacturer’s Web site for a current driver, or use the installation CD that came with the device.

The Tablet PC is in the FlexDock, but the system does not recognize any accessory devices, such as the external disk drive or monitor
- The Tablet PC may not be fully seated in the dock. Remove the Tablet PC from the dock and then replace it.

Network

The wireless adapter keeps connecting even when I do not want it to
- The wireless adapter is enabled. You can use Motion Dashboard to disable the wireless adapter. See “Enabling or disabling Wi-Fi” on page 58.

I cannot connect to a network using the Ethernet adapter
- The Ethernet cable may not be connected properly. Remove and reconnect the Ethernet cable or replace the cable.
Audio

**No sound is coming from the built-in speakers**

- Ensure that nothing is connected to the audio out port. Connecting headphones or external speakers disables the built-in speakers. Disconnect the headset or external speakers if not in use.

**No sound is coming from any speakers**

- The volume may be set too low or muted. You can use Motion Dashboard to increase the volume or turn mute off.
- The integrated audio components may have been overwritten. If you install a third-party audio device (such as a USB or Bluetooth device), the integrated audio may stop working. If this happens, reinstall the audio drivers. After you install these, if you still have problems recording, contact Motion Computing Technical Support.

System

**I forgot my BIOS password and cannot access my computer**

- You can enter several incorrect passwords before the BIOS temporarily locks the system. You can try again by restarting the system. If you still cannot log on, contact Motion Computing Technical Support at www.motioncomputing.com/support.

**An application has stopped responding, but I can still move the pointer and use other applications**

- The application may have stopped responding. Use Task Manager to manually stop the application. (Press the Windows Security button and tap **Start Task Manager**.) See Windows Help and Support for more information.

**The computer seems to be operating more slowly than usual**

- The hard disk drive may be full or nearly full. You can use Disk Cleanup to free up space on your hard drive. For more information, open Windows Help and Support and search for “disk cleanup”.
- The hard disk may need to be defragmented. You can use Disk Defragmenter to consolidate files and folders on the hard drive. For more information, open Windows Help and Support and search for “disk defragmenter”.
- Reboot
Appendix A  Troubleshooting and Support

Frequently asked questions

How can I make the battery charge last longer?
• For maximum conservation, you can use the **Power saver** power plan. See “Selecting a power plan” on page 40.
• Use the Dynamic brightness display setting. This automatically controls the display brightness to conserve power. See “Adjusting the display brightness” on page 35.
• Set the display brightness to the dimmest level you are comfortable with. See “Adjusting the display brightness” on page 35.
• Disconnect any Ethernet connections that are not being used. Disable the wireless adapter and Bluetooth adapter if you are not using them. Disconnect unnecessary USB devices.
• Stop unnecessary background applications and processes.

What do I need to use the Tablet PC in another country?
• You will need a travel plug adapter. You can find these in airports and travel stores. You do not need to buy a voltage converter; the Motion AC adapter will automatically adjust to different voltages.

How do I clean the View Anywhere display screen?
• To clean the View Anywhere display screen, wipe it with a soft cloth (like the one supplied). If needed, clean with any alcohol-based product recommended for use on anti-reflective glass. Other cleaning products may leave a residue. Do not spray cleaners, spray/pour any liquid, nor wipe any abrasive cleaner on the screen nor any surface of the Tablet PC. Do not use tissues or paper towels to clean the screen. They contain wood fibers and may scratch the surface.

How do I clean the standard display screen?
• To clean the acrylic display screen, wipe it with a soft cloth (like the one supplied) onto which you have sprayed a window-type cleaner. Do not spray cleaners, spray/pour any liquid, nor wipe any abrasive cleaner on the screen nor any surface of the Tablet PC. Do not use tissues or paper towels to clean the screen. They contain wood fibers and may scratch the surface.

Will scratches affect the performance of the display or digitizer?
• Our testing has not found appreciable loss of performance on a scratched display.

How sensitive is the screen to various elements?
• As with any computer or electronic device, you should protect the Tablet PC from liquids, dirt and sand, other contaminants, and extreme heat.

Will any monitor, USB device, keyboard, or mouse work with the Tablet PC?
• If the device has a driver for Windows, it will work with the Tablet PC. For a list of products that have been tested for Windows, go to the Windows Marketplace Tested Products page at winqual.microsoft.com/hcl.
Why is the Tablet PC lacking parallel, serial, and PS2 (mouse) ports?

- Microsoft Tablet PC certification requires the system to be completely Grab-and-Go—that is, to be able to dock with and undock from all accessories without putting the system into suspend or shutting it down. Connecting through legacy ports such as serial, parallel, and PS2 often requires suspending or restarting the system, which prevents you from moving between desktop mode and mobile mode seamlessly in one docking/undocking step.

How do I adjust the Tablet PC for left-handed use?

- Open the Tablet PC Settings window. You can select left- or right-handed and change the location of the menus. You should calibrate the Tablet PC screen if you change any pen options (page 7).

Specifications

You can use System Information to find out more about your hardware and software environment. From the Start menu, choose All Programs > Accessories > System Tools > System Information.

You can find the specifications for other Motion Computing products at www.motioncomputing.com/products.

Warranty and Insurance Programs

Motion Computing currently provides limited warranties on Motion products and accessories. See the Warranty packaged with your Motion product or accessory or visit our Web site at www.motioncomputing.com.

In addition, Motion Computing offers extended warranties along with various screen and configuration insurance programs. Go to the Motion Computing Support and Services page at www.motioncomputing.com/support.

Service and Support

If you need help with your Motion Computing J3400 Tablet PC, go to the Motion Computing Support and Services page at www.motioncomputing.com/support.

This page will provide you links to all the information you need about Motion products, technical support, customer services and professional services.
Index

Numerics
10/100/1000 Base-T Ethernet
about 19
using 32
802.11a/g/n
about 20
enabling 58
setting up 58
using 58

A
AC adapter
about 21
adjusting display brightness 35
air vent 4, 5
ambient light sensor 2, 17
audio in port 5
audio out port 5
Automatic Updates 55

B
backup procedure 69
battery 3
about 22
checking status 43
gauge 44
notification area status 43
swapping 47
tips 45
using 43
battery gauge button 3
battery power indicator lights 3
battery release switch 3
battery status light 4
BIOS
setting a password 56
Bluetooth
about 21
discovery 61
enabling 60
setting up 60
tips 61
using 60
bookmarks, using 1
buttons
about 11
configuring 30
functions 11, 32

C
calibrating the digitizer 7
calibrating the pen 7
camera 2, 11
disc 3
capturing a fingerprint 51
card slots cover 4
care and maintenance
display 64
fingerprint reader 66
general care 63
pen 67
repair and recovery 69
replacement pens 67
replacing pen tips 67
screen 64
tablet pen 67
View Anywhere display 64
character pad 29
checking battery gauge 44
checking battery status 43
configuring
front panel buttons 30
ten options 29, 30
connecting
external speakers 38
headphones 38
microphone 38
cord 21
Ctrl+Alt+Del 4
customizing buttons 30

D
Dashboard
starting 26
using 26
Dashboard button
about 2, 11
configuring 30
dictation mode 38
digitizer pen
  about 10, 28
  calibrating 7
directional pad 2, 11
disabling
  the eraser 29
  the pen button 29
display
  about 16
  brightness 35
  dynamic brightness 35
  extended 37
  features 16
  fixed brightness 35
  mirrored 37
  rotating 36
  using 35
disposing of used batteries 47
docking connector 19
docking port 5, 19
document, about 1
dynamic brightness 35

E
  enabling
    802.11a/g/n 58
    Bluetooth 60
    eraser 29
    Mobile Broadband 59
    pen button 29
    Wi-Fi 58
eraser
  about 28
  enabling 29
Esc button
  about 2, 11
  configuring 30
Ethernet
  connections 6
  port 19
  using 32
Ethernet port 5
Express card
  about 20, 35
  using 20, 35
Express card slot 4, 20, 35
extended display 37
external display
  connecting 19
  using 36

F
  FAA wireless air travel requirement 68
  features overview 9
  finding additional tablet PC software 62
  fingerprint reader 4
    about 16
    setting up 51
    tips 53
  five-way directional controller 2, 11
  fixed brightness 35
  FlexDock
    connector 3
  frequently asked questions 76
  front panel buttons
    about 11
    configuring 30
  Function button
    configuring 30

G
  getting started 6
  Gigabit Ethernet 19

H
  handwriting recognition
    about 28
    using 29
  hardware overview 2, 9
  HDD password, setting up 57
  headphones port 5, 18
  headphones, connecting 38
  Hibernate
    about 42
    using 42

I
  Input Panel
    using 29
  insurance 77
  integrated microphones 17, 37
  integrated speakers 17
  Internet Options 55

K
  keyboard 29

L
  landscape mode 36
Index

LCD
  about 16
  care and cleaning 64
  View Anywhere 17
Li-ion battery 22
liquid crystal display See LCD
Lithium-ion battery See Li-ion battery
logging on to a remembered site 54

M
maintenance
  backup 69
  recovery 69
maintenance procedures 63
memory card slot 20, 35
microphone port 5, 18
microphones
  about 17
  built-in 2
  external 38
  using 37
mini-plug 21
mirror display 37
Mobile Broadband
  enabling 59
  using 59
monitor only display 37
monitor port 19
Motion Dashboard
  using 26
Motion Dashboard button 11
Motion DataGuard 17
Motion QuickNav 2, 11

N
network connections 6
network port 19
networking
  Bluetooth 21
  wireless 20

O
OmniPass
  about 16, 51
  starting 51
on-screen keyboard 29
ordering replacement pens 67
overview
  hardware 9
  ports and connectors 2
password replacement
  about 53
  using 54
pen 4
  about 10, 28
  actions 10, 28
  calibrating 7
  care and maintenance 67
  configuring options 29, 30
  storing 28
  tether 28
Pen and Button Options 29, 30
pen tether 4
plug 21
port covers 5
portrait mode 36
power adapter
  about 21
  port 5
power button 4
power cord
  about 21
QuickNav 2, 11
recovery procedure 69
removing the battery 46
removing the SIM 48
replacing pen tips 67
replacing the battery 46
replacing the SIM 48
right-clicking 10, 28
RJ-45 jack 19
Rotate button
  configuring 30
  rotating the display 36
running the repair and recovery procedure 69
Secure Attention Sequence
  about 4
security
  features 15
  using 15
security slot 5, 19
service 77
Index

setting up
802.11a/g/n 58
a BIOS password 56
an HDD password 57
Bluetooth 60
the fingerprint reader 51
the tablet PC 6
users and passwords 56
Wi-Fi 58
Windows user accounts 56
shoulder strap attache point 5
shoulder strap connection 4
SIM
removing and replacing 48
SIM slot 20
Sleep 41
about 41
using 41
smart card 19
smart card reader slot 19
smart card slot 4
speakers 2, 17
speakers, external 38
specifications 77
speech recognition
about 38
setting up 38, 39
Sticky Notes 11
support 77
swapping batteries 47

T
tablet only display 37
Tablet PC Input Panel
using 29
TPM 15
traveling with your tablet PC 68
troubleshooting
audio 75
battery 72
display 72
input 73
network 74
ports and connectors 74
power 71
system 75
Trusted Platform Module 15
turning on the tablet PC 7

U
universal serial bus See USB
USB
about 18
using 32
USB 2.0 ports 5
using
802.11a/g/n 58
battery 43
Bluetooth 60
Ethernet 32
Express cards 20, 35
external display 36
handwriting recognition 29
Hibernate 42
Input Panel 29
microphones 37
Mobile Broadband 59
OmniPass 51
power plans 40
security 15
Sleep 41
speech recognition 38
this document 1
USB 32
Wi-Fi 58

V
VGA port 19
Video (VGA) port 5
View Anywhere display 17
voice commands 38

W
warranty 77
Wi-Fi
about 20
enabling 58
setting up 58
using 58
Windows Firewall 55
Windows Security button 4
Windows Security Center
about 55
using 55
wireless
802.11a/g/n 20
Bluetooth 21
wireless networking 20, 21
writing pad 29